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Chapter 1. Installing RepeaterNet

This chapter briefly describes the components of the RepeaterNet software, identifies minimum
system requirements, and describes the installation procedure.

RepeaterNet Craft Software

The RepeaterNet Craft software (Craft) provides Windows 95- and Windows NT-based
configuration management and alarm monitoring for individual Repeater Technologies repeaters
and dynamically manages sessions in real time through one of these connections:

= A laptop computer with a direct connection to the repeaters—a technician can visit
repeater sites and connect to the repeaters directly using the serial port on the laptop.

= A laptop or desktop computer with a modem connection to the repeater—with the modem
connection, a technician need not visit the physical repeater sites to connect to the
repeaters.

The Craft user interface varies, depending upon the mode! repeater being configured or
monitored.

NOTE: You must have Administrator priviledge to install Craft 2.1 software when running
Windows NT.

Minimum System Requirements
Craft system requirements include:
=  Pentium 120 MHz running Windows 95 with 32 MB of memory

=  Approximately 10 MB of free disk space
= Modem {if a modem connection is to be used)

NOTES:

= The Craft systern must be used with Windows 95 with Service Pack 1 Update (Version
4.00.950 A) or later releases or Windows NT, Service Pack 3 Update.

= Use “Hayes-compatible” modems only. “Connect with Rockwell” certified for modems of
56K and above. US Robotics modems are not supported.

= If you use a fax program such as Microsoft Fax, make sure that the Auto Answer feature is
disabled. See Appendix D. Troubleshooting on page 33, Problem 7, for how to disable
Auto Answer for Microsoft Fax.

Installation Procedure

The OA1900C NR Craft software is distributed on 3 HD floppy disks. To instali:

1. insert Disk 1 in your a: drive.

2. From the Windows Start menu, select Run.

3. Type a:\setup and click on OK.

4. Follow the online instructions to install the Craft software.

The Craft software comes with default configuration files, which you can download to your
repeater according to the repeater type and nurmber of channels. This eliminates the need to
configure the properties manually. See Download Properties on page 22.
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Chapter 2. RepeaterNet Craft

Configuring the Repeater Connection

You must use the RepeaterNet Craft Admin program to configure the connection to the repeater
before you can access the RepeaterNet Craft software. Foliow this path from the Start menu to

invoke the RepeaterNet Administrator;

Start -> Programs -> RepeaterNet Craft 2.1 -> RepeaterNet Craft Admin
When you invoke the Administrator, a window such as the following is displayed:

You can save both Direct and Dial-Out {(Modem)
configurations, but remember to assign a unique
COM Port Number to each. Also, be sure to
check Use this connection for only one of the
configurations. The connection checked is the
connection RepeaterNet Craft uses to connect to
the repeater.

For example, you may assign the connection type
as Direct through COM Port 1. You can check
the Use this connection box to make this your
default configuration. Click on Save.

Next, you can save a Modem configuration to
another COM port, such as COM Port 2

* : RepeaterNet Craft Admin E
- Direct Connaclion
COMPotumbee T
™ Uss this connaction

r- Modem Connection
COM Port Humbes Il)

Phone Number —

T~ Use this conrmction

Lk

1. Assign a COM Port Number that is different from the COM Port Number used for Direct

connection.

2. Click on Save, then click on OK to exit RepeaterNet Admin.

Starting Craft

Double-click the Craft icon to display this window.

RepeaterNet connects to the repeater and displays
the Craft Main Control screen for the QA1800C NR.

Unttled - Repeaterfiet

Craft for the OA1900C NR
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OA1900C NR Craft Main Control Screen

The Craft Main Control screen provides access to all monitor and control functions of the
OA1900C Network Repeater (NR).

Main Control screen icons (labeled on the following screen) provide access to subsystem status
screens and report alams.

. Untitled - RepeéferNet

Elle Configuration System QOptions Hslp

Forward Channel 1
Front End Fomard
Power
Channel 1 Amblifier
Forward Channel
Select Filter Channel 2
Forward
Channel 2 Power
Forward Amnlifier
Channel Select
Filtar Channel 1
Reverss Channel
Channel 1 Selact Filter
Reverse Reverse Front End
Power
Amplifier
Diversity Front End
Channel 2
Reverse
Power Channel 2
Amplifier Reverse Channel
Select Filter
et —
{ | |
Alarm Control Modem  Cell Phone Power Back-up Power
Unit Supply
CA1900C NR Craft Main Control Screen
NOTES:

= All units are shipped with PAs tumed OFF as indicated by the PA OFF indicalor (a circle
with a slash through it) displaying over each PA subsystem icon (FPA and RPA). PAs
should remain OFF until gain is adjusted.

=  The Main Control screen displays differently depending on the hardware configuration of
the unit. For example, Channel 2 icons are grayed-out (unavailable) for a single-channel

repeater.

Craft for the OA1900C NR
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Configuration

Configure the OA1900C NR on subsystem Properties screens, which you can display from the
Craft Configuration menu.

The Configuration menu contains the following:

FrontEnd...............cveevne. Forward, Reverse, and Diversity
Channel1..........coooceeene. Available on ali units

Channel 2............................ Available on 2-channel units oniy
Alarm Control Unit............... ACU

Modem ..o, internal or extemal modem option
Cellular phone ..................... Cellular option only

Power System ............c........ Input, battery, and internal

UPS i Backup power system

Status Reporting

Once you have configured the repeater, you can monitor and control repeater system functions on
subsystem Status screens. Click a subsystem icon to open its status screen.

When an alarm is triggered, the subsystem icon changes appearance, blinks, and activates an
audible alarm. Clicking on the icon and viewing the subsystem status screen stops the blinking
and the audible alarm. The display of the icon does not revert to normal until the alarm condition
is cleared.

The display of the Forward PA and Reverse PA icons also indicate the operational status of the
PAs. If a PA is OFF, a circle with a slash is displayed over the associated icon.

When RepeaterNet displays a subsystem as disabled, that subsystem is not available to the
repeater. For exampie, in repeaters without a cellular phone, the cellular icon is displayed in light

gray.
Alarm Status Reporting on the Main Control Screen

RepeaterNet uses a color system to report subsystem alarm status on the Main Control screen.
The meanings of the colors, and color independent icons, is shown in the following table.

Color-Independent
Subsystem Alarm Status lcon Color Icon Action
Normai— No Alarm Green N/A N/A
Critical Alarm Red X Call Out
Major Alarm Yellow N Call Out
Minor Alarm Blue e, Call Out
Event White None None
Disabled Dark Gray* N/A None
System Not Available Light Gray N/A N/A
* When all alarms in an individual subsystem are disabled or set to event severity, the icon
color displays in dark gray.
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When an alarm is triggered, the icon color of the affected subsystem changes from green
(normal) to the color of the alarm definition, and the icon btinks.

RepeaterNet also offers two optional alarm features:

=  Color Independent Icons is provided for operators unable to distinguish colors
=>  Alarm Sounds adds an audible atarm

Should more than one alarm within an individual subsystem be triggered, the higher severity
alarm is reported on the Main Control screen.

For example, if both a major and a minor Reverse PA alarm triggers, a yellow subsystem icon is
reported. If the major alarm is cleared while the minor alarm remains active, a blue subsystem
icon is reported. Color-independent icons also report the higher severity alarm, should more than
one alarm on an individual subsystem be triggered..

NOTE: When an subsystem alarm is friggered, click the icon (to open the status screen} to
terminate the icon blinking feature and silence the audible alarm. Icon color continues to
report and a color independent icon (if applicable) continues to display until the alarm is
cleared. Color reporting does not apply to subsystems set to Event severity.

Defining Alarm Severity

The OA1900C NR is factory-configured with a standard set of alarm severity settings. Adjust
atarm severity on the subsystem Properties screens. See Chapter 3. Configuring OA1900C
NR Properties on page 6 for more information about alarm severity and the factory configuration.

The levels of alarm severity are:

=  Critical
=  Major
=  Minor
= Event
=  Disabled

To define alarm severity:
1. Login to a session with the repeater.

2. Select Configuration from the Main Control menu bar, then select a subsystem to open its
Properties screen. For example, select Configuration -> Channel 1.

The Alarms tab is displayed.
3. Click the down-arrow next to an Alarm field to select a new alarm severity.
Click Apply or OK.
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Chapter 3. Configuring OA1900C NR Properties

Use the subsystem Properties screens to perform configuration of the repeater. To open a
Properties screen, select a subsystem from the Configuration menu.

Front £nd

Channel 1

Channel 2

Alarm Control Unit

Modem

Cellular Phone

Power System

upPs

The Properties screens display tabs specific to each subsystem. Some subsystem Properties

screens include tabs for redefining alarm severity and specifying operational settings; others have
a single tab for redefining alarm severity.

Configuration includes:

LU sy

=  Redefining alarm severity Foswasd FE. | Revemes FE | Diverety FE | Oivwray FE Gan |
=  Specifying operational settings [darm Domcrption ] Sovesy ]
for the repeater FdFE Alam Props Maior il

Front End Properties

The Front End Properties screen lets
you configure the Front End subsystems.
This screen includes tabs that let you set
the alarm severity for:

—> Forward FE
= Reverse FE
=  Diversity FE

ok | coos | s | v

Forward FE Tab Fomard FE Peverse FE. | Diversky FE | Divrity FE Gain |
The Forward FE tab lets you set the [ Aluues Dovorption T Sovedy
alarm severity of the Forward FE alarm. FodE P paee Prope oo =

The Forward FE alarm is activated when
the forward signal power level is too
strong and is being attenuated to protect
the repeater from possible damage.

NOTE: Do not adjust power amplifier gain
while this alarm is active.

Reverse FE Tab

The Reverse FE tab lets you set the alarm
severity of the Reverse FE alarm. The
Reverse FE alam is activated when the reverse signal power level is too strong and is being
attenuated to protect the repeater from possible damage.

ok ] cowet | soow | hee |

NOTE: Do not adjust power amplifier gain while this alarm is active.
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Diversity FE Tab

The Diversity FE tab lets you set the
alarm severity of the Diversity FE Alarm
and set the gain of the Diversity receiver.

The Diversity FE alarm is activated when
the Diversity Receive signal power level is
too strong and is being attenuated to
protect the repeater from possible
damage.

NOTE: Do not adjust power amplifier gain

while this alarm is active.

Diversity FE Gain Tab

Gain must be carefully balanced in any

Formard FE | Peverse FE  Divarsly FE | Diveraky FE Gain |

| Alasm Dosodption ] Sovedy ]
Diversity FE Alarm Props Minoo =l

[ ] _comal | oo | e |

application to ensure proper hand-off and system operation. Note that RepeaterNet detects the
configuration of the repeater and displays the applicable gain range on the Diversity FE Gain tab.
You can adjust the Diversity FE gain. The adjustable gain range depends upon the type of
repeater you are using and the power level of the power amplifiers.

To adjust Diversity FE gain:
1. Select Configuration ->Front End to

open the Front End Properties screen.

Click the Diversity FE Gain tab.

Click-drag the horizontal sliders to
define forward and reverse gain,
noting that gain adjusts in 2 dB
increments. The gain value box
(centered under slider} displays
selected gain.

4. Click Apply or OK,

Channel Properties

From the Main Control screen menu bar,

T —

Forwerd FE | Flevarse FE | Diversity FE Civersiy FE Gain |

select Channe! 1 or Channel 2 {for 2-channel units only) to open a Channel Properties screen.

Channel properties include:

Reverse PA
Forward PA
PA Control
Reverse Filter
Forward Fiiter
Channel! #
Gain

guuuyguld
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Channel Reverse PA Tab _
[Channel 1Properies [

The Reverse PA tab shows the most recent Revarse PA Pa] P4 Cortrol | Reverse et | ®
alarm state, including severity, date, and | Fomwspa] I P | Fomet P

time, for these alarms:

| Aloyra Doecsplion | Severdy

PA Alarm RevPAT Alarm Props Evert v
Indicates a component failure in the iparioiduiiby ol o 4
power amplifier; the repeater is RevPA1 Ext Shutdown Alarm Frops Maicr v
inoperative.

VSWR Alarm
Indicates a problem with the Voltage to
Standing Wave Ratic.

Thermai Alarm
Indicates the system temperature has
exceeded the alarm threshold. The o ]
repeater has been shut down. When =
the temperature falls below subsystem
tolerances, the repeater automatically reactivates the PA.

External Shutdown Alarm
Indicates that the repeater has been shut down by a user; also activates one RPA alarm.

Cocd | ooy |

Redefine alarm severity for the Reverse PA subsystem on this tab.

1. Click the down-arrow next to an Alarm field to select a new alarm severity.
2. Click Apply or OK,

See Forward PA for a sample screen.

Channel Forward PA Tab

The Forward PA tab shows the most recent alarm state, including severity, date, and time, for
these alarms:

PA Alarm B - 0

power amplifier; the repeater is Raverss P, Formard PA | PA Control | Reverse Fibe | Forward Fter | Chan 4] 2
inoperative, —— Toemy
VSWR Alarm | e o
indicates a problem with the Volitage to FudPAT Thormal Alarm Frops Criical
Standlng Wave RatiO. FrdPAT Est Shutdown Alamn Picps Miror

Thermal Alarm
Indicates the system temperature has
exceeded the alarm threshold. The
repeater has been shut down. When the
temperature falls below subsystem
tolerances, the repeater automatically
reactivates the PA,

External Shutdown Alarm Lo ] cmes | o | v |
indicates that the repeater has been shut
down by a user; also activates one RPA alamn.

Redefine aiarm severity for the Forward PA subsystem on this tab.

1. Click the down-arrow next to an Alarm field to select a new alarm severity.
2. Click Apply or OK
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Channel PA Controf Tab

The PA Control tab provides a switch to turn
PA power ON or OFF.

1. Click on ON or OFF in the PA Power box
to change the value.

2. Click Apply or OK for the setting to take
effect.

Channel Reverse Filter Tab

This tab displays the most recent alamm state
for a single channel select filter alarm. A
failure in the Reverse Filter assembly triggers
an alarm and the filter becomes inoperative.

Redefine alarm severity for the Reverse
Filter subsystem on this tab.

1. Click the down-arrow next to an Alarm
field to select a new alamm severity.

2. Click Apply or OK

Values are Disabled, Event, Minor, Major,
and Critical.

See Forward Filter for a screen example.

Channel Forward Filter Tab

This tab displays the most recent alarm state
for a single channel select filter alarm. A
failure in the Forward Filter assembly triggers
an alarm and the filter becomes inoperative.

Redefine alarm severity for the Forward
Filter subsystem on this tab.

1. Click the down-amrow next io an Alarm
field to select a new alarm severity.

2. Click Apply or OK.

Values are Disabled, Event, Minor, Major,
and Critical.

Channel # Tab

The Channel # tab lets you set the operating
channel or band for Channel 1 or Channel 2.
Once you select a channel, the
corresponding frequencies are displayed.
Consult your network administrator or the
system Site Plan for the proper channel or
band setting.

“hzanne! 1 Properties B

Ravese P | Fovwaed PA. [P ToREc | Roverss Fiker | Forwerd Fiter | Ch t 14|

=] [

o] comed | 2o |

Cnannel 1 Properties [ x|

Roverss PA.| Fovasd P | PA Contol | Reverse Fter (Fomard Pl | Chery t |4

I%_d

—
C5F1 Fwd Alewm Props

fT_] I:del M/J Hﬁl

Channel 1 Properties [ ]

Forveerd PA | PA Cortol | Revarse Fier | Forwasd P Charrel 8 { B |4 0
Charsl Musber —
Foresad Fraquancy (ibiz) 195000
Faverse Frequercy Piiz) &
S Charnel ]
Muinun Charnel &%
Charvel Spacing (KHz) %

T ox ] caed | aeen |
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Channel Gain Tab

iChanne! * Properties

RepeaterNet detects the configuration of P Cariral | Frevarse Fter | Fowart Fie | Oharrel#t (B3| R

the repeater and displays the applicable
gain range on the Gain tab. You can
adjust Forward and Reverse gain for the e e e e )
selected channel. & BE

The adjustable gain range depends upon
the type of repeater you are using and the - B
power level of the power amplifiers.
RepeaterNet limits gain adjustment to P =8
valid selections oniy. s

NOTE: Set gain for the Diversity Receiver
on the Diversity FE tab of the
Front End Properties screen. o ) _coca | oy | v |

Gain must be carefully balanced in any
application to ensure proper hand-off and system operation.

To adjust Forward PA or Reverse PA gain:
1. Select Configuration ->Channel 1 or Channel 2 to open the Channel Properties screen.
2. Click the Gain tab.

3. Click-drag the horizonta! sliders to define forward and reverse gain, noting that gain adjusts in
2 dB increments. The gain value box (centered under each slider) displays selected gain.

4. Click Apply or OK.

ACU Properties

Select Alarm Control Unit from the Main Control screen Configuration menu to open the ACU
Properties screen. This screen includes tables for VO Descriptions, I/0 Control, Alarms, and
DC Voltage Alarm Threshold.

The ACU subsystem provides alarm and control functions for the repeater. The ACU monitors all
the repeater subsystems and reports status to a connection device or to remote devices through a
dial-up modem connection. In addition to monitoring the repeater system, the ACU contains a
number of external inputs and outputs to monitor and control external devices.

Inputs and Outputs

RepeaterNet lets you monitor two digital alarm inputs and one DC voltage input from external
devices. You also can activate up to four external devices with two relay outputs and two digital

outputs.
NOTE: Alarm settings for digital input 1 and digital input 2 are initially set to Disabled.

The inputs and outputs are as foliows:

Relay Outputs 1 and 2
The two relay outputs are configured with three leads in a Form C Contact Closure, with
normally closed and common connectors closed with the switch in the OFF position and
normally open and common connectors closed with the switch in the ON position.
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Digital Oufputs 1 and 2

The two digital outputs each have two
leads that provide an opto-isolated
circuit that presents a low impedance
connection when the switch is in the
ON position and a high impedance
connection when the switch is in the
OFF position.

Digital inputs 1 and 2
The two digital inputs each have leads
that generate an alarm condition if the
leads form a low impedance circuit (a
closed contact), and a clear condition if
the leads form a high impedance circuit
(an open circuit).

For information about connecting inputs
and outputs to the repeater, see the
OA1900C NR Operations Manual.

ACU I/O Descriptions Tab

Labe! external equipment connected to the
repeater's inputs and outputs using the 1O
Descriptions tab. External equipment could
be a security light or any other site
equipment.

To add IO Descriptions:

1. Select Configuration->Alarm Control
Unit to open the ACU Properties screen.
The /0O Descriptions tab is active.

2. Provide I/O Descriptions in available data
fields.

3. Click Apply or OK.

ACU IO Controls Tab

The /O Controls tab contains switches to
turn Relay Outputs and Digital Outputs for
channels 1 and 2 ON or QFF.

See Inputs and Outputs on page 10.

ACU Alarms Setting Tab

Redefine alarm severity for ACU
subsystems on the Alarms Settings tab.

1. Click the down-arrow next to an Alarm
fieid to select a new alarm severity.

2. Click Apply or OK.

Values are Disabled, Event, Minor, Major,
and Critical.

Alarm Centrol Unit Properties
143 Davscviptiors. | 113 Conole | Alane | £3¢. DT Volage |
Entar the descriptions for the device's inputs and oulputs.

 Outputy
Boieyi:  [aodd QO foeee
Fighey 2 ';ﬁd_ Digtal W—
- inpus
oC |m— Dptall e
D2 [
7] cacs | s |

Elarm Ceontrel Unit FProperties

V0 Descrptions (PO Tarbk | slwma | £ OC volage

~Fslay Outputs ————————  ~ Digial Gutpete
1 2 1 2
[dboded [ g [woope™ [t
T oo | s |

Carcet | aoob |
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ACU DC Voltage Alarm Threshold Tab

RepeaterNet can monitor an external DC voltage power source (a battery) in a range of 0 to 60
volts in 250 mV increments. In addition to monitoring the voltage level, you can define upper and
lower limits for the voltage that is to activate the DC Voitage alarm in the ACU subsystem.

Monitor the voltage of a DC power source “larm Control Unit Properties

(supplied by you) used to power external » )
site equipment using the DC Voltage U1 Deecipiors | 1) Conis | A Seting (EE T Vknge |

Alarm Threshold tab. An alarm is triggered

if the voltage fluctuates from a defined Dielirw e minierm and masmn vakaps hat tigoe: the Esemal DC
operating range. OC Vokage

To define an operating range for DC I

voltage: gream [0 2]

1. Select Configuration->Alarm Control
Unit to open the ACU Properties

screen.
2. Click the DC Voltage Alarm
Threshold tab. T8k ] cocd | &b | b |

3. Define (type in or arrow-click) the
normal operating range for the DC power source in the Less Than and Greater Than data

fields.
4. Click Apply or OK.

Modem Properties

From the Main Control screen menu bar, select Configuration->Modem to open the Modem
Properties screen. This screen has two tabs:

Alarm Setting
Lets you set the alarm severity for the Modem alarm. This alarm indicates a faiiure of the

internal modem.

Modem Setting

Lets you define the port settings for the Ao Soking | Mocem Seting| Pager Setirg|

internal or extemal modem.
Adwm Deacrigtion 1 Sovesiy i
Pager Setting Wodor Alam e
Lets you configure a pager to be notified
when a certain severity level alam
QCCUrS.

Alarm Setting

Use the Alarm Setting tab to redefine alarm
severity for the repeater's modem.

1. Click the down-arrow next to an Alarm
field to select a new alarm severity. [ox ) cood | o |

2. Click Apply or OK.
Values are Disabled, Event, Minor, Major, and Critical.
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Modem Setting
Define modem settings for the repeater's modem using the Modem Properties tab.

1.

To define modem settings: tlodem Properties
Select Modem from the Main Control Aome Setirg  Moden Setrg | Pege Setirg |
screen Configuration menu to open the Setup S¥ng E
Modem Properties screen. Poabube: [0
Click the Modem Settings tab. ol Aderncts: P
Define the Setup String, Phone Rasdfioe X -
Number, and Call Attempts. Pariy None =

Setup String is reserved for configuring Dais e Dl Typm
a celi phone or modem. L  Jow
1 g ’  Puke
NOTE: The cell phone setup string is 537=6 —m

4.

Phone Number is the phone number of a [Tox ] cocs | o |
remote computer to be called. This value
is 0 unless you are using RepeaterNet

Network Management software or other network management software.

Call Attempts is the number of callout attempts before disconnecting; a zero (0) disables
calling.

Click Apply or OK.

Changes made to the default settings on the Modem Properties screen take effect upon exiting
RepeaterNet.

Note the following about modem settings:

=  Baud Rate is adjusted automatically downwards by the modem when necessary
=>  Parity must be set the same as the computer's modem

=  Data Bits must be set the same as the computer's modem

—>  Dial Type usually is Tone

In addition:

=

If you configure a repeater to automatically call out and report alarm status, the repeater COM
port settings must match the settings of the modem to be cailed.

For users to log in to the repeater with a modem, the port settings of their computer's modem
(defined in the configuration file) must match the settings of the repeater modem.

If the repeater is equipped with an internal modem, the setup string is controlled automatically
by the repeater's hardware. If the repeater is connected to an external modem, consult the
modem’s documentation for the setup string.

Changes you make to the default settings on the Modem Properties screen take effect upon
exiting RepeaterNet.
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Pager Setting

You can set RepeaterNet to send out a page when a
certain severity level alarm occurs with the Pager
Setting tab.

A page is generated if the summary alarm severity is
greater than or equal to the Minimum Severity you
select. When a page request is detected, the repeater
terminates any current modem connection and
generates a page. The page format consists of the
repeater number followed by the severity level; for
example, 123456-2.

If a change in the current alarm severity is detected,
note the following:

l

tladem Properties

Aoy Sotirg | Ml Seting  Pager Seting, |

Page Nurber {9108 5551212,
Coll Aempts: R
Bepotier Nusber: ]'1_—
MN—M.
[Tk ] cewd | sow |

= If the Minimum Severity is set to Major and a Major alarm comes in, a page with a severity of

2 is generated.

= If a Critical alarm is detected, page is generated again with a severity of 3 (Critical plus Major).

= If the Major alarm is cleared but the Critical alarm remains, a page is generated with a severity

of 1 (Critical)

= If the Critical alarm is cleared, a page is generated with a severity of 0.

= If a Minor alarm is detected, no page is generated because the Minimum Severity is set to

Major.
= Events do not generate a page.

Severity numbers are:

No Alarms 0 Minor

Critical 1 Critical + Minor

Major 2 Major + Minor

Critical + Major 3 Critical + Major + Minor

To set a pager:

1. Click on the Pager Setting tab of the Modem Properties screen.

2. Enter the Pager Number, the number of times RepeaterNet should attempt to call the pager
number (Call Attempts), and the number of the repeater (Repeater Number).

The Pager Number is the phone number to be called. This reflects the pager phone number,
including networking access number (9), 1, and area code (if needed). Access the network dial
number and wait 5 seconds before sending the page sequence.

Several commas must follow the phone number—each comma generates a delay of 1 second.

Generally, it takes about 3 seconds for the pager company to pick up the line, and a maximum of
5 seconds before they drop the connection. A good delay would be 5 seconds, in which case you
would add 5 commas; for example, 9 1 (408) §55-1212,,,,, . Spaces, dashes, and parentheses
are ignored.

Enter the Call Attempts, which are the number of retry calls to be attempted. A value of 0 in this

3.
field disables paging.
Enter the Repeater Number (a system identification number or description).
5. Select the minimum alarm severity for paging. Values can be Critical, Major, or Minor.

Click on Apply to set the vaiues without exiting the properties screen, click on OK to set the
values and exit.
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Cell Phone Properties

From the Main Control screen Configuration
menu, select Cellular Phone to open the Cell
Phone Properties screen.

The Alarms tab lets you set the alarm severity
for the Cellular Alarm. This alarm indicates a
failure of a cellular phone.

To change alarm severity:

1. Click the down-arrow next to an Alarm
field to select a new alarm severity.

2. Click Apply or OK.

—<il phone Froperues

Ab—l
[ Al Descripion 1 Soverty ;
Ced Phone Al Frops Minoe |

T ok} ceced | Aoow

Severity levels include Disabled, Event, Minor, Major, and Critical.

NOTE: This severity should be minor. The Cell Phone alarm is generated when the cell phone fails
to report an alarm after afl retry attempts by either the modem or the pager. This alarm clears
when the cell phone succeeds in reporting an alarm.

When there is no cell phone, the Cell Properties selection is disabied.

Power System Properties

From the Main Control screen Configuration
menu, select Power System to open the
Power System Properties screen. This
screen lets you access initial configuration
settings for the power subsystem.

Redefine alarm severity for Power systems
using the Alarms tab.

1. Click the down-arrow next to an Alarm
field to select a new alarm severity.

2. Click Apply or OK.

Values are Disabled, Event, Minor,
Major, and Critical.

Pewer System Properties

Yy

Channeil PS Inps Power Alasm Props Cotcal

Channall PS Power Supply Alam Props Wmor

Chanrai! PS B sttery Alam Props Magor >

[T ] coost | s

L

The Alarm Settings tab lets you set the alarm severity of the following alarms:

Input Power Alarm

The input power to the repeater is out of system tolerances.

Power Supply Alarm

The internal system power of the repeater is out of tolerances.

Battery Alarm

The voltage of the internal battery is below tolerances. This battery supplies power fo the
ACU, modem, and cell phone in the event of a system power failure, letting the repeater call
out and report its status. It also supplies power to the memory that stores the Alarm and

Event Log.
Battery Charger Alarm

The internal battery charger is not charging the intemal battery.

NOTE: The internal batiery does not provide power for RF components and the repeater will not
be able to provide RF coverage during a power failure.
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Backup Power System (UPS) Properties

The UPS Properties screen lets you access initial configuration settings for the optional, external
backup power supply.

From the Main Control screen menu bar, (RN ]

select Configuration -> UPS to open Alaws St |
the UPS Properties screen.
Redefine alarm severity for backup AT P u:m!s
power systems using the Alarms L ey A v —
Setting tab. AN -
1. Click the down-arrow next to an Tampes Alam Props M
Alarm field to select a new alarm
severity.
2. Click Apply or OK.
Values are Disabled, Event, Minor, ok ) cwom | oo | v |

Major, and Critical.

You can set the severity for the following alarms:

AC Fail Alarm
Indicates that the input power to the BUPS has failed. In this case, the BUPS provides 40 or
80 amp-hours (depending upon which BUPS mode! is installed) of backup power for the
repeater before shutdown. (The AC source powers the charger.}

Battery Low Alarm
Indicates that battery voitage of the BUPS is below operating tolerances and the BUPS
cannot power the repeater.

Battery High Alarm
Indicates that battery voltage of the BUPS is above operating tolerances and the BUPS
cannot power the repeater.

Charge Fail Alarm
Indicates that the internal charger of the BUPS has failed and the BUPS is unable to
recharge its batteries.

Summary Alarm
Indicates that one or more of the BUPS alarms have been triggered.

Tamper Alarm
Indicates that the door of the BUPS is open.
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Chapter 4. Monitoring OA1900C NR Status

Monitor and control repeater system functions on subsystem Status screens. Click a subsystem
icon to open its Status screen.

Each Status screen includes one or more of the following tabs:

Alarms
Reports present subsystem alarm states, with date and time stamps.

Measurements
Reports power and operational temperature measurements, including Low and High values.
A Reset Low/High button resets values.

Voltages
Reports present voitages for a subsystem.

Control
Includes ON/OFF switches for intemnal and external subsystem hardware.

Status screens for the OA1900C NR are:

= Front End Status
= Channel Status

¢ Filter Status (Forward and Reverse)
¢ PA Status (Forward and Reverse)

Alarm Controf Unit (ACU) Status
Modem Status

Cellular Phone Status

Power System Status

UPS Status

Ly

Front End Status

Click an FFE (Forward Front End) icon to display the Front End Status screen. The Front End
Status screen Alarm tab reports these
alarms: Foreard Frort End Status

Forward FE alarm
Activated when the forward signal
power level is too strong and is
being attenuated to protect the
repeater from possible damage.

Reverse FE alarm
Activated when the reverse signal
power level is too strong and is
being attenuated to protect the [T ] comw | gan | v |
repeater from possible damages.
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Diversity FE alarm
Activated when the Diversity Receive
signat power leve! is too strong and is
being attenuated to protect the repeater
from possible damage.

Channel Filter Status

Click a Channel 1 or Channel 2 filter icon
(sine waves) to open a filter Status screen,
which reports a CSF1 Forward Alarm
(Forward Filter) and CSF1 Reverse Alarm
(Reverse Filter) with date and time
stamps. A failure in the Reverse or
Forward filter assembly triggers an alarm.

Channel PA Status

Click a Channel 1 or Channel 2 FPA or
RPA icon to open a PA Status screen.

PA Alarm Tab

The PA Alarms tab reports subsystem
alarms with date and time stamps: A
failure in the Forward or Reverse PA
assembly triggers an alarm.

PA Measurement Tab

The Channel 1 and Channel 2 PA
Measurement tabs reports the output
power of the repeater, including iow and
high output values. To reset low and high
output values, click Reset Low/High.

ACU Status

Click the ACU icon to open the ACU Status
screen. There are two tabs—Alarm and

R ———

pae | e .|
mﬁ- iﬁ*i o 2 198 cm’amm

Apx 24,199 031306 A
Age 24,196 031306 Am
Ap 24158 01306 AM

FondP] Thamet Mlom Tais 132500 -
FouPA1 Ent Shubdown Al St oS00

Cihacnel T Foryara PR StaTas

_wi

Medmmnant p Liw
Measurement. i ol Sond TN 2 S0 Pemiowtn|
o) oo | o | |
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ACU Alarm

The Alarm tab reports subsystem alarms
with date and time stamps. A failure in the
ACU assembly triggers an alarm.

The ACU alarms include:

External Input Alarms (1 and 2)
An alarm generated from optional,
external equipment.

Temperature Alarm
The system temperature threshold has
been exceeded.

Tamper Alarm
The repeater door is open.

Analog input Alarm
The upper or lower limits for monitoring
of the analog input DC voltage source
have been exceeded.

Measurement

The Measurement tab reports current, low,
and high system temperature and DC
voltage source values. Click on the Reset
Low/High button to reset the low and high
values.

Modem Status

Click the Modem icon to open the
Modem Status screen, which reports a
modem alarm with a date and time
stamp. Internal modem component
failure triggers an alarm.

Cell Phone Status

Click the Celt Phone icon to open the

Cell Phone Status screen, which reports

a Cell Phone Alamm with a date and time
stamp. Internal celliular phone component
failure triggers an alarm.

[Tk ] come | 20w | e |
YN u—-u—l]
Tharre!l Temg V. 00 a6
DMAE'JUA.—:;W“ o0 0o a0 w

Nem |
D { .
Wodem Alarm Sisks j.— %*l Au?:ﬁ szsle
o ] _coww | v | e |
Ahl
Tim
Ao 17 1SR 37 D AM
o | cwer | ao | e |
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Power System Status

Click the Power icon to open the Power System Status screen. This screen allows access to
monitoring and operating tasks for the repeater's power subsystem.

Alarm

The Alarms tab reports the status
of the following alarms with
severity, date, and time information
for each:

input Power Alarm
Indicates the input power to the
repeater is out of tolerances.

Power Supply Alarm
Indicates system power of the
repeater is out of tolerances.

Battery Alarm
Indicates the voltage of the
internal battery is out of

o IVnhu]
M%—h Ape 24,1998 0920 20 AM
Crennalt PS Powsr Supply Als... Ao 2d, 1998 032020 AM

Agr 24,1358 0322020 AM

[ ] comm | oo | heo |

tolerances. This battery supplies power to the ACU, modem, and cellular phone in the event
of a system power failure, letting the repeater call out and report its status. It also supplies
power to the memory that stores the Alarm and Event Log.

Battery Charger Alarm

indicates that the internal battery charger is not charging the intemal battery.

NOTE: The internal battery does not provide power for RF components and the repeater will not
be able to provide RF coverage during a power failure.

Voltages

The Voltages tab shows the current
power values for Battery Voits,
Channel 1 PA Volts, and Channel 2 PA
volts.

Pouver System Status

Mam Volages |
_Descrpion 1 !
Charrsil PS Battery Vols 0o
Charrell PS Vols 0o
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UPS Status
The UPS Status screen aliows access monitering of the optional, external backup power supply.
This screen includes an Alarms tab, which dispiays the alarm status of the following alarms:

AC Fail Alarm
Indicates that the input power to the
BUPS has failed. In this case, the
BUPS provides 40 or 80 amp-hours
{depending upon which BUPS model
is installed) of backup power for the
repeater before shuidown. (The AC
source powers the charger.)

Battery Low Alarm
Indicates that battery voltage of the
BUPS is below operating tolerances
and the BUPS cannot power the T ok ] oot | con | o |
repeater.

Battery High Alarm
Indicates that battery voltage of the BUPS is above operating tolerances and the BUPS

cannot power the repeater.

Charge Fail Alarm
Indicates that the internal charger of the BUPS has failed and the BUPS is unable to

recharge its batteries.

Summary Alarm
Indicates that one or more of the BUPS alarms have been triggered.

Tamper Alarm
Indicates that the door of the BUPS is open.
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Chapter 5. RepeaterNet Commands

Commands available from the OA1900C NR Main Control screen’s menu bar are described in this
chapter.

File Menu—OQA1900C Craft

Open the Main Control screen File menu to display the RepeaterNet commands described in this
section.
Download Properties

You can download all settings previously uploaded to a repeater with the Download Properties
command. You can use Download Properties to:

= Download the default configuration file distributed with your Craft software to avoid having to
manually configure each setting.

= If you have used the Upload Properties command to store repeater configuration settings.

The following preset configuration files are distributed with RepeaterNet Craft installation software
and can be found by following this path:

Program Files -> Repeater Technologies -> RepeaterNet Craft 2.1 -> Config Files

Configuration File Configuration
OA1900C_2_Chan_NMS.rcf OA1900C repeater without modem or phone
OA1900C_2_Chan_ModemPhoneNMS rcf 0OA1900C repeater with modem or phene

To download settings to a repeater using the standard repeater configuration file:

1. From the Craft Main Control File menu, select Download Properties; a confirmation box is
displayed to give you an opportunity to
change your mind about the download

Salect File to restore repaater properties from

operation. Lookjx {3 NS 21 ol olfEw
2. Click on OK to proceed; a Select file to ﬂ:

restore box is displayed.

3. Select the repeater configuration file
whose properties you want to

download.
4. Click on Open to proceed with the Fngene: B o= ]
download. Fios of ppe:  [Repsster Coriig Fies " ] =] Carcel_|
™ Open as pad-orly
Upload Properties

System settings are stored in a repeater configuration (.rcf) file, which you can use to download all
settings from one repeater to additional repeaters in a network, or to configure a replacement unit.

Once you have configured a repeater, you can upload the configuration from that repeater to your
workstation with the Upload Properties command. You then can use the Download Properties
command to copy the configuration to individual repeaters in your network.
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To upload system settings and create a
repeater configuration file:

1. Select a repeater and open Craft.

2. Select File->Upload Properties to
open the Select a file to save
repeater properties to dialog box.

3. Enter a name for the file without a file
extension. An rcf extension is added
automatically to the file name; for
example, filename.rcf.

Click Save to initiate the upload.

5. Click OK when the upload is
complete.

Seiect a file to save repeater properties to

Sevein  [CINMS 21 8 olEm

hewelg rcf

update icf

Fapems:  JRE | Fove |

Save st e [Repostar Confg Fies [*1cf Rd) Concal |
T Open & adonky

Save a copy of the repeater configuration file on a floppy disk for safekeeping.

NOTES:

=  When you create a backup file, be aware that Repseater Configuration {.rcl) files created
using a Network Monitor login include IDs and passwords.

=  The Repeater Configuration (.rcf) file is saved in the RepeaterNet program directory.

Update Repeater Firmware

Install a firmware upgrade with the
Update Repeater Firmware command.
Note that firmware updates are sent
automatically to the designated point of
contact for every affected owner of the
repeater. Update packages are sent using
ovemight delivery and inciude a detailed
hotice, a fioppy disk, and installation
instructions. Any questions conceming the
update shouid be directed to the Repeater
Technologies Customer Service
Department.

To install a firmware upgrade:

1. Read documentation provided with the
firmware upgrade.

2. Login to a session with the repeater to be
upgraded.

3. Insert the upgrade disk into the computer's
floppy drive.

4. From the Main Control screen menu bar,
select File->Update Repeater Firmware.

An Open dialog box is displayed to let you
save the repeater's configuration. You can
choose to select a file into which the
configuration shouid be saved, or click on
Cancel to proceed with the firmware update.

Selact a file to save repeater properties to

Saveic  [SINMS 217 -l o) & = m)
Prowach ref
update. rcf
Flogme o]
Save ma pype. |Repeater Config Fies (" 1ci) ] Carcsl I
1™ Dpen ox pond-only

Select a firmvare file to downioad to the repeater FEl:

PRV [=TTTFY BRI

Fopeen | Lo _|

Flesof e [Firmears Hes " ¢09] R | .l,
I™ Opan s psasony
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- To save the configuration and continue with the firmware update, select an .rcf file
and click Open.

— If you do not want to save the repeater configuration, click on Cancel.

— Clicking Open or Cancel causes the upload operation to proceed. an
Uploading Repeater window displays the progress of the upload.

5. When the upload is complete, the Select a firmware file to download to the repeater box is
displayed. in the Look In box, select the drive in which the upload disk is located.

6. Double-click the upgrade file. It is labeled with an .809 extension—for example, filename.s09.
The previous firmware version is overwritten.

7. When the upgrade is complete, the repeater's configuration is restored automatically from the
file you chose in the Open dialog.

Exit

The Exit command ends an active session with RepeaterNet and returns to the Welcome screen.

Configuration Menu—OA1900C NR Craft

initial configuration of the repeater is done from the Configuration menu commands. See
Chapter 4. Configuring OA1900C NR Properties on page 6 for detailed information.

System Menu—OA1900C NR Craft

Open the System menu to display the Properties and Alarm and Event Log commands
described in this section.

Properties
Select Properties from the System menu to open the System Properties screen.

NOTE: When the repeater is on a network, the system name must be entered to match that at
the Network Management Station in order for unsolicited alarms to be recognized.

System Tab

The System tab includes data fields for storing site-specific information—the system name (name
of the repeater), brief site information (such as a network name or city location), and the repeater
phone number for a repeater with a modem option.

Entering summary data on the System Tab, f-ietam Dropertizs

although optional, is recommended. As a Syvtam | Sywim vty | Svars Login |
minimum, type a name for the repeater in the Syutom Nane: = —
System Name field: during automatic reporting,

the repeater name is displayed in the title bar of Shoer feas

the Main Control screen, identifying the selected Sla ik f
repeater. PNt B

To record system data:

1. Type required information in the data fields.
2. Click Apply or OK.

(o] _cmon | dow | ne |
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System Inventory Tab

The System inventory tab includes data fields that provide information about the repeater to
which you are connected. RepeaterNet reads this information directly from the repeater upon

successful login.

These information-only fields are described
as follows:

Assembly Part Number
The part number of the repeater (for
example, 880-1200-09).

Serial Number
The 9-digit serial number of the
repeater.

Date Code
The date the repeater was built.

Hardware Revision
The repeater hardware revision (such
as Rev. A).

Boot Code Version

System Froperties E1

Sy {Systan Ivuriony ) 5 putos Login |
Asyersbiy Past Number: m“‘"
Date Codec .
Hardveare Vorsion
Irstabed Cptione: F
Fiwwsare Versior: T0-02-04
[T ] cow | _som |t |

The version of the boot code installed in the repeater.

installed Options

Optional internal equipment in the repeater (such as a cell phone).

Firmware Version

The firmware version installed in the repeater.

Login Tab

The Login tab includes fields to type in login IDs and passwords and to configure the Auto-Logout

function.

In the Auto-Logout Inactivity Time fieid, define how long RepeaterNet should wait, during a
period of inactivity, before terminating a session. A time interval in minutes between 1 and 80 can
be defined independently for each access level. If you enter a zero in a time field, this feature is

disabled.

NOTE: When the repeateris part of a
network, the time field must be zero

(0).

To change a login ID or password;

1. Login to the repeater (as an
administrator).

2. Select Properties... from the System
menu.

3. Click the Login tab.

Type the new login 1D or password (using

six or fewer characters) into the
appropriate fields.

5. Write down login iDs and passwords and
secure in a safe place.

|
Sywiew | Syetom Irwartcey  Sywara Logh |

. Auto-Logot

[ lognTye [ Llognid [ Passwd oy Tieme

Lot [oRaFT [pa800 P4

Homeork Moritur [NETMON Joag00 {0 -

Erctoy | ! =
ok ] cace | b |
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6. Click Apply or OK to set the new information.
7. Notify affected operators of ID and password changes.

NOTE: When the repeater is networked, this information also must reside in the NMS Database.

Alarm and Event Log

Open the Alarm and Event Log from the System menu to view the alamm and event history of
the OA1800 NR. The log is dynamically updated during viewing.

Line entries in the Alarm and Event Log are organized as follows:

1. Subsystem affected by an alarm or event
2. Alarm severity
3. Date and time stamp

Saving , Printing, and Editing the Log

Alarm and Event Log entries can be printed, saved, or edited using Notepad. Click on Run
Notepad; a copy of the Alarm and Event Log is displayed in a Notepad window, in which you can
edit the log. To print or save the log, select Print or Save as... from the Notepad File menu.

Options Menu—OQOA1900C NR Craft

Open the Options menu to display the Color Independent Icons and Alarm Sounds
RepeaterNet commands.

Color Independent Icons

Color Independent Icons are special graphic indicators designed to assist operators unable to
distinguish colors. As part of the alarm reporting system, Color independent icons display on the
Main Control screen for a Critical, Major, or Minor alarm. By default, the Color-Independent Icons
feature is OFF.

From the Main Control screen menu bar, select Options->Color independent icons to turn ON
this feature.

Alarm Type Color Independent Icon
Critical Alarm X

through subsystem icon

Major Alarm AN through subsystem icon

Minor Alarm .’°-,_ through subsystem icon

-

Alarm Sounds

The Alarm Sounds feature allows for an intermittent alarm to activate when a subsystem triggers
an alarm. By default, the Alarm Sounds feature is OFF.

From the Main Controt screen menu bar, select Alarm Sounds from the Options menu to turn
ON this feature.

NOTE: During an alarm, either clicking a subsystem icon to open the Status screen or cleanng
the alarm silences an audible alarm.
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Hold Connection

The Hold Connection feature maintains the direct or dial-in connection to the repeater for
monitoring unti! you terminate the connection.

Help Menu—OA1900C NR Craft

RepeaterNet on-line help is designed to provide quick access to information related to the
operation of the repeater.

=  To open RepeaterNet Help, select Help->Help Topics.
=  Tolearn about the version of RepeaterNet Craft, RepeaterNet NMS, or RepeaterNet
Administrator instalied, select About... from the Help menu of any program window.

Navigating Help

=  From the Contents tab, double-click a book icon to open its contents, then double-click
a topic icon to open its Help page. A help page provides detailed topic information.
Help pages can contain links—identified by green, underlined text—to related topics.

=  From the Iindex tab, type a topic name in the data field to automatically jump to a topic
or use the scroll bar to locate a topic entry. Double-click an index entry to open its Help

page.
Click the Index tab to open the Find Setup Wizard utility, which searches for specific
words and phrases instead of searching by category. Follow the prompts.

=  Tofind out the version of RepeaterNet in use, select About from the Main Control
screen Help menu.
Exiting RepeaterNet
To exit RepeaterNet, return to the Main Control screen Fife menu and select Exit.
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Appendix A. Default Alarm Settings

Subsystem Option Alarm Defauit Setting
Front End Forward Fwd FE Alarm Critical
Reverse RevFE Alarm Critical
RevFEProtect Alarm Critical
Diversity DiversityFE Alarm Critical
Channel 1 Reverse PA Rev PA Alarm Critical
Rev PA VSWR Alarm Critical
Rev PA Thermal Alarm Major
Rev PA Ext Shutdown Alarm Major
Forward PA Fwd PA Alarm Critical
Fwd PA VSWR Alarm Critical
Fwd PA Thermal Alarm Major
Fwd PA Ext Shutdown Alarm Major
PA Control Reverse PA OFF
Forward PA OFF
Reverse Filter CSF Rev Alarm Event
Farward Filter CSF Fwd Alarm Event
Gain Forward and Reverse 6508
Channel 2 Reverse PA Rev PA Alarm Critical
Rev PA VSWR Alarm Critical
Rev PA Thermal Alarm Major
Rev PA Ext Shutdown Alarm Major
Forward PA Fwd PA Alarm Critica!
Fwd PA VSWR Alam Critical
Fwd PA Thermal Alarm Major
Fwd PA Ext Shutdown Alarm Major
PA Control Reverse PA OFF
Forward PA OFF
Reverse Filter CSF Rev Alarm Event
Forward Filter CSF Fwd Alarm Event
Alarm Control Unit (*If external inputs or | External Input 1* Alarm Disabled
(ACU) equipment are used, | Extemnal Input 2* Alarm Disabled
set alarm severity as | Temperature Alarm Minor
appropriate.} Tamper Alarm Major
Analog Input Alarm Disabled
Ext. Growth Box Alarm Disabled
Power Supply Channel PS Input Power Critical
Power Supply Alarm Critical
Battery Alarm Minor
Battery Charger Alarm Disabled
Backup Power Supply AC Fail Alam Disabled
Low Battery Alarm Disabled
High Battery Alarm Disabled
Charge Fail Alarm Disabled
UPS Summary Alarm Disabled
Tamper Alarm Disabled
Modem Modem Alarm Minor
Celi Phone Celf Phone Alarm Minor
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Appendix B. RepeaterNet Executables

The installation program installs all necessary application executables and associated support
drivers in a Windows folder you select or, by default, in ¢: \Program Files\Rspsater
Tachnologies\ RepeaterNet. The installation program also provides entries into the system
registry.

The main RepeaterNet executable files are:

CraftAdmin
The Database Administrator program used to configure and seiect the communications port

used by RepeaterNet Craft.

RepsatarNet
The Craft graphical user interface for different repeater hardware types. Used in the setting
and viewing of individual repeater items.

When any of these executable files are running, an icon is displayed on the Windows Task Bar.

Craft for the OA1900C NR Appendix B. RepeaterNet Executables — Page 29



Appendix C. The Oki Cellular Phone

Accessing the OKI Cellular Phone

The celiular phone is located on the inside door of the OA1900C NR entry box. Unscrew the four
screws securing the metal box lid.
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NOTE: The AC charger and cell phone antenna are provided in the accessory kit.

Programming the OKI Cellular Phone

An abbreviated set of instructions for NAM programming of your Oki Phone is provided
in this section. For more detailed information, see your OKi PHONES 1400 Series
documentation.

Programming Mode Access
1. Turn the power on and press Rel + Func keys at the same time.
2. Enter your 5-digit special password within 30 seconds.

3. After the special password is logged in successfully, ESN/HEZ Number
and Software Varsion Number are displayed for two seconds each.

Two seconds later the Speed Dial Memory reset prompt is displayed.

Proceed to the next section, “Speed Dial Memory Clear,” or press
volume YA to scroll within the NAM Programming menu.
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Speed Dial Memory Clear

Scroll the NAM Programming Menu until “Spd dial” appears n the display,
followed by the reset prompt (“reset-0"). Press 0 to clear the Speed Dialing Memory.

Default Data Set

Scroll the NAM programming menu until *def data” appears on the display, followed
by the reset prompt (““reset-0"). Press 0 to reset all user programmable functions to
the Manufacturer's default.

Lock/Unlock Code Programming

1. Scroll the NAM Programming Menu unti! “Uloc and (current code)” appears on
the display. The default is “1234."

2. Enter a new 1-to-4 digit unlock code and press Sto key.
Telephone Number Programming

1. In this menu, you can program information that is unigue to Telephone #1.
Follow the instructions or press Clr to skip to Telephone #2 or the next item
on the main NAM Programming menu.

2. The display indicates “tel.no 1" followed by the last seven digits of the
current phone number. Enter the new number (area code pius telephone
number) and press Sto.

Authentication Key Programming

The display indicates “Auth.no.” followed by “Entr.no.” Enter the authentication
key provided by the carrier (up to 26 digits) and press Sto. If an invalid number
is entered, the display shows “not good” followed by “Entr.no.”

Home SiD Programming

Enter a 5-digit SID number and press Sto. The IPCH Number Initia) paging
channei number is set automatically depending on the stored Home SID number.

ACCOLC Number

The current number is displayed. Enter a new number if required, then press Sto.
GID Number

1. The current number is displayed. Enter a new number if required, then press Sto.
2. Press Clr to return to the main NAM Programming menu.

Emergency Number

1. The display shows "Help no.” and the current setting. Enter a new number
(up to 11 digits) if required.

2. Press Sto.
Preferred SID Programming

1. Scroll the Preferred NAM Programming menu. Press Rcl and enter the
desired Preferred SID number (5 digits).

2. Press Sto. You can enter up to 50 SID locations.
Press Clr key to advance to the next programming option,

Craft for the OA1900C NR Appendix C. The Oki Cellular Phone — Page 31



Language Option Set

Press Rcl and scroll through the available options.
When the desired language is displayed, press Sto.
System Options Programming

1. Scroll the NAM Programming menu and press Rcl to enter the Option
Programming menu.

2. While in this menu, press Rel to change settings and Sto to save and
go on to the next setting. Press Cir at any time to return to the main
NAM Programming menu.

Option bits are definedasfollows: 0 0 01 1 0 1 0

0 = Reserved for future use

Reserved for future use

= Reserved for future use

= MINMK = Mobile ID Number Mark (0=No, 1=Yes)
LUMK = Local Use Mark (0=No, 1=Yes)

AMMK = Audio Mute Mark {0=Call, 1=Always)

HFMK = Handsfree Mark (0=No, 1=Yes)
HAMK = Hom Alert Mark (0=No, 1=Yes)

Q= O =2 2 00
]
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Appendix D. Troubleshooting

The following attempts to identify the most common problems associated with the successful
operation of the RepeaterNet systemn. The steps listed to resolve the problem may not include all
of the possible reasons for non-operability, but may assist in identifying the actual difficutty. The
problem attributes in the following paragraphs have been ordered with the most likely problem
listed first.

If you continue to have problems, call Repeater Technologies Customer Support for assistance.
See inside the front cover of this document for current telephone numbers.

Problem 1: The RepeaterNet Server reports that it cannot open the NMS database.

Either the DSN is configured improperly, does not point to the proper location, or the system did
not find the DSN itself. Call Customer Support for assistance.

=  The comrect DSN or User ID is not identified.
=  The Windows ODBC drivers are not installed.
=  The database file pointed to by the DSN is corrupted or needs repair.

Problem 2: The Process Manager component of the RepeaterNet Server reports that it
cannot read the database Ports table.

No ports have been configured in the system database.
The Ports table in the database may be corrupted. Repair the database and retry.

Problem 3: The System starts up without error but, when a repeater graphical user
interface is launched, no detailed data is displayed..

Wait for up to 4 minutes (cell modem connection) to see whether the program can connect to the
repeater. If not, a wamning will pop-up indicating communications could not be established.

Problem 4: A specific port does not seem to be in use and an Alert exists, or the
database log reports the error “Unable to initialized port COMn” where n is
the designation of the non-functioning port.

The port number has been configured incomrectly or the port does not exist.

The port is assigned to another program operating in the same PC. Windows does not permit the
sharing of communications ports between active programs. Shut down the other program.

Problem 5: The system reports “Unable to connect to repeater...”

This can be an indication of:

=»  The cellular carrier is not handling the call

The phone number provided is incorrect or out of service
A problem with the modem or phone line

IR

A problem with the repeater
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Problem 6: The system reports the message “An unsupported operation was
attempted.”

This message appears when the installation failed to register the OLE controls for alarm bitmaps.

Problem 7: RepeaterNet conflicts with Microsoft Fax.

To disable the auto answer mode:

1. Open the mail icon from the Control Panel.

2. Select Microsoft Fax from the Services tab.

3. Click on the Properties button.

4. Select either Manual or Don’t answer radio button.
Click OK to save.

Problem 8: NMS Client reports “Cannot find application RepeaterNet Server.”

This can occur when the Server is not running or a network failure prevents the NMS Client from
connecting to the Server. Verify that the Server is running and that the Server's host is
accessible.

Another possibility is a conflict with the port assigned to the Server. This problem has been
known to occur with a port number that previously had no conflict. Run the program
*RepNetConfig.exe” in the RepeaterNet directory and increase the value of “Server Port” by one.
Restart the Server and NMS Client.
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